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1 INTRODUCTION 
Welcome to the IApioneer training course. This course is designed for new and experienced users of 

remote sensing and digital photogrammetry software. 

In this course you will master the basics of 3D feature extraction using overlapping imagery. In addition, 

you will learn more about exporting data into common formats used by other geospatial processing 

software. 

There are six modules in this training manual. Each module contains lessons that you work through in 

class with the help of your instructor. The lessons are built upon basic tasks that you are likely to 

perform in your regular production workflow. They provide instruction for using the IApioneer software 

to developed exploit aerial and satellite imagery, including annotation, precision point mensuration, and 

creation of accurate 3D site models. 

1.1 ABOUT THIS MANUAL 
The IApioneer training manual is for use in a classroom setting with a qualified instructor. Your 

instructor is available throughout the course to answer any questions you may have. 

Each module in this manual contains a series of hands-on lessons that let you work with the software 

and a set of sample data. Lessons have brief introductions followed by tasks and procedures in 

numbered steps. 
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2 CONFIGURATION 
In this lesson, you learn to set personal preferences within the IApioneer environment by: 

 Setting measurement preferences 

 Setting data directories 

 Setting default parameters for viewers and annotations 

2.1 CUSTOMIZING IAPIONEER 
IApioneer settings are saved on a per-user basis. Therefore, you will need to configure your personal 

settings every time you sit down at a new installation of IApioneer. 

To customize the IApioneer settings: 

1. Go to the Backstage by clicking on the Home tab on the Ribbon. 

2. Click on the [Settings] option to launch the user settings dialog. 

There are three (3) primary categories of settings: Configuration, Viewers, and Analysis (IApioneer). The 

Configuration section allows you to customize your geolocation and measurement formats, as well as 

your data repository sources. The Viewers section allows you control over how images load into the 

viewer, and some custom viewing options. The Analysis (IApioneer) section gives you control over how 

annotations are initially created. 

2.2 CONFIGURATION OPTIONS 
Configuration options give you control over the geolocation and measurement formats for both display 

and input. Also, there are options for setting the DTED and data repositories for direct ingestion into 

IApioneer. 

To edit the Geolocation Display Formats: 

1. From the tree view on the left of the Settings dialog, select Geolocation Formats. 

2. The Projection Type can be chosen from Geographic (latitude/longitude), UTM, or Native. Native 

projections include custom local projections such as State Plane or country-specific projections. 

Set the option to Geographic 

3. The Geographic String Format is where you specify the output string format for latitude and 

longitude configurations, in a variety of degree-minutes-seconds formats. Set the option to 

DDD.D for a decimal degrees output. 
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4. The Vertical Datum type can be chosen from HAE (Height Above Ellipsoid) or MSL (Mean Sea 

Level). IApioneer uses the EGM96 tables for MSL elevations. Choose MSL (EGM96). 

5. The Vertical Units type controls what units the elevation values are displayed in. Choose from 

Meters, Foot (international), or Foot (US) for the most common units. Set the option for Meters. 

To edit the Input Formats: 

1. From the tree view on the left of the Settings dialog, select Geolocation Formats. 

2. The Projection Type can be chosen from Geographic (latitude/longitude) or Cartesian (UTM, 

State Plane, etc.). Choose Geographic. 

3. The Geographic String Format is where you specify the output string format for latitude and 

longitude configurations, in a variety of degree-minutes-seconds formats. Set the option to 

DDD.D for a decimal degrees input. 

Note: These formats apply to viewers and dialogs within IApioneer only, and not to any third party tools 

such as the GTI precision mensuration workflows. 

 

Measurement options give you control over the measurements made using the built-in measurement 

and analysis tools in IApioneer. 

To set the measurement units: 

1. From the tree view on the left of the Settings dialog, select Measurement. 

2. The Length type controls what units the elevation values are displayed in. Choose from Meters, 

Foot (international), or Foot (US) for the most common units. Set the option for Meters. 

3. The Angles type controls what units angular measurements are displayed in. Choose from 

Degrees or Radians. Set the option for Degrees. 

4. The Area type controls what units the area measurement values are displayed in. Choose from 

Acres, Square Meters, or Square Feet (US) for the most common units. Set the option from 

Square Meters. 

 

The Data discovery options allow you to set the data repositories for the data discovery dialog. Older 

versions of IApioneer may not contain options for data discovery. 

To set the data repositories for discovery: 

1. From the tree view on the left of the Settings dialog, select Data Discovery. 

2. Use the Add button to add a local or remote directory to the data discovery repository. 

3. Use the Remove button to remove a directory from the data discovery repository. 
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Note: When directories are first added to the data repository, IApioneer may take some time to build the 

metadata tables for lookup, depending on the number of files in the repository and the types of the files. 

This process runs in the background, and should not impact performance, except in the Data Discovery 

dialog. 

 

The Terrain options allow you to set the terrain repositories for the DTED catalog. IApioneer uses the 

DTED files in the priority order specified in this setting, with the highest priority coverage listed first in 

the dialog. 

To set the DTED data directories: 

1. From the tree view on the left of the Settings dialog, select Terrain. 

2. Use the Add button to add a local or remote directory to the DTED repository. 

3. Use the Remove button to remove a directory from the DTED repository. 

4. Use the Up and Down arrows to adjust the priority order. 

2.3 VIEWER OPTIONS 
The Viewer options allow you to configure parameters for how images are loaded in to the viewers, 

pixel cursor appearance, and overlays. 

To edit the pixel cursor: 

1. From the tree view on the left of the Settings dialog, select Pixel Cursor. 

2. Select the Inner and Outer Color for the pixel cursor. Contrasting colors chosen here help 

distinguish the cursor across all image color configurations. 

3. Select the size (Small, Medium, or Large) to reflect the cursor size. 

 

To specify the default orientations of images when they are loaded into the viewer: 

1. From the tree view on the left of the Settings dialog, select Display. 

2. From the Image Orientation dropdown, select the desired orientation (Image is Up, North is Up, 

or Z is Up). 

 

Gridline overlays provide contextual reference for the image’s geospatial location, and can aid in some 

exploitation tasks.  
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To set the properties for the gridline overlays: 

1. From the tree view on the left of the Settings dialog, select Gridlines. 

2. Under the Grid Lines section, select the Line Color and Line Style for the gridlines. 

3. Set the Major Axis for the major gridlines, including the Line Weight and Interval. 

4. Set the Minor Axis for the tick marks, including the Line Weight and Interval. 

5. Set the label appearance by selecting the desired Label Color, Font, Size, and Label Format. 

Note: Whenever the Grid overlay is selected for display in a viewer, it will pull from these settings. 

 

The Region of Interest overlay controls a number of capabilities, from highlighting areas of importance, 

to providing a rubber-band functionality for selecting areas to be chipped or processed. 

To set the visible properties for the ROI mechanism: 

1. From the tree view on the left of the Settings dialog, select ROI. 

2. Set the Line Color for the ROI box. 

3. Set the Line Weight and Style for the ROI box. 

2.4 ANALYSIS (IAPIONEER) OPTIONS 
The Analysis (IApioneer) options specify the default properties of the IApioneer annotation objects, 

including: footprints, mensuration tools, points, point markers, polygons, polylines, target rings, and 

textboxes. 

To set the properties for the mensuration tools: 

1. From the tree view on the left of the Settings dialog, select Mensuration Tools. 

2. Use the Font controls to specify the Font, Font Style, and Size properties of the text labels. 

3. Set the Effects desired for the font in the text labels (Strikeout or Underline). 

4. Use the Color pickers to choose the foreground (text color) and background colors for the text 

labels. 

5. Set the Line Properties by choosing the Color, Style, and Weight of the mensuration graphics. 

Note: Changes made to the text settings can be previewed in the Sample section of the textbox settings. 

 

 

A point is a single annotation calling out a specified location with a closed circle. 
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To set the properties for a point: 

1. From the tree view on the left of the Settings dialog, select Point. 

2. Use the Point Color property to specify the color of the point annotation. 

3. Use the Point Style and Weight properties to specify the appearance of the point annotation. 

 

A point marker annotation is the point circle with an attached textbox callout defining the point 

marker’s location. The text properties are pulled from the Textbox settings (see below). 

To set the properties for a point marker: 

1. From the tree view on the left of the Settings dialog, select Point Marker. 

2. Use the Marker Color property to specify the color of the point annotation. 

 

To set the properties for a polygon: 

1. From the tree view on the left of the Settings dialog, select Polygon. 

2. Set the Line Properties by choosing the Color, Style, and Weight of the polygon annotation. 

3. Check the Show Endpoint Direction box to show the direction the polygon was drawn. 

4. Check the Show Centroid box to display the centroid of the polygon. 

5. For a filled polygon, choose the appropriate Fill Color. 

Note: When a polygon is copied or subdivided, all of its properties will pass down to the newly created 

objects. 

 

To set the properties for a polyline: 

1. From the tree view on the left of the Settings dialog, select Polyline. 

2. Set the Line Properties by choosing the Color, Style, and Weight of the polygon annotation. 

3. Check the Show Endpoint Direction box to show the direction the polyline was drawn. 

 

To set the properties for target rings: 

1. From the tree view on the left of the Settings dialog, select Target. 

2. Set the Marker Color for the center of the target rings. 

3. Set the Damage Ring Units. 

4. Specify the Radius and Color for each ring. 



UNCLASSIFIED 
 

UNCLASSIFIED 

®2015 IAVO Research and Scientific - IApioneer Demo Manual v3.0.3 – September 2015 Page 7 

5. Add new rings by clicking the Add Ring button and specifying their radii and colors. 

6. Remove existing rings by clicking the Remove button beside the ring. 

Note: Ring radii do not have to be ordered. 

 

To set the properties for textboxes: 

1. From the tree view on the left of the Settings dialog, select Textbox. 

2. Use the Font controls to specify the Font, Font Style, and Size properties of the text labels. 

3. Set the Effects desired for the font in the text labels (Strikeout or Underline). 

4. Use the Color pickers to choose the foreground (text color) and background colors for the text 

labels. 

5. Set the Line Properties by choosing the Color, Style, and Weight of the mensuration graphics. 

Note: Changes made to the text settings can be previewed in the Sample section of the textbox settings. 
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3 DATA PREPARATION 
In this lesson, you learn to setup your session by: 

 Creating a new project 

 Adding your images to the project 

 Specifying math models and spatial referencing information 

 Creating new vector layers 

 Saving your project 

In this lesson, you will set up a new project using digital aerial optical images. The procedures are similar 

for working with scanned film or satellite images. 

Before beginning, ensure that the Raleigh Demo Set has been loaded onto your machine. This dataset 

consists of eight high-resolution aerial images over the Raleigh, NC area, with supporting metadata files. 

For simplicity’s sake, we suggest you create a folder in the root directory for ease of access (e.g., 

C:\3DFE Aerial Data\). Hereafter, we will refer to this set of imagery as the Demo Data, and this location 

as the Demo Data folder. 

3.1 STARTING A NEW SESSION 
IApioneer works on a Session – a group of images and vector files that you use to create your product. 

Therefore, you need to open a new session or create a new session before you can access the IApioneer 

functionality. IApioneer is always working with a session, even when no data are loaded. 

To create a new session (when data is already loaded): 

1. Go to the Backstage by clicking on the Home tab on the Ribbon. 

2. Click [Close Session]. 

3.2 ADDING IMAGES TO THE PROJECT 
This section describes how to add aerial images to the session. 

To ingest images into the session: 

1. From the Backstage, select [Load Data]. 

2. Locate the Demo Data folder. 

3. Select all the images in the Demo Data folder. 

4. Click [OK]. The images will load into the Session section of the Backstage. 
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3.3 SPECIFYING SENSOR MODEL INFO 
This lesson describes how to prepare eight aerial images for processing, as part of the Data Preparation 

stage. To set up the sensor models for your data, you will need the following: 

 Aerial images 

 Camera calibration (interior orientation) information 

 Camera positioning (exterior orientation) information 

 Spatial referencing information 

To specify the sensor model information for a batch of aerial images: 

1. Ingest the images, as per Lesson 3.2. 

2. From the Backstage, select [Batch Aerial Workflow]. 

3. Open the Raleigh-IO.txt file from the Demo Data folder, using a text editor. 

4. Since the demo images are from a digital sensor, under the Sensor Affine grouping, select the 

Digital radio button. 

5. Enter the values given in the Raliegh-IO.txt file into the appropriate fields in the Batch Aerial 

Workflow dialog. 

6. Select [Next]. 

7. Set the Spatial Reference System for the images to that provided. In this case, the images were 

acquired in the NAD83 State Plane NC (3200) US Feet system. 

8. Set the exterior orientation File Format to ImageID X Y Z Omega Phi Kappa. 

9. Set the Input Angular Unit to Degrees. 

10. Using the browse button beside the Text File field, navigate to the Demo Data folder, and select 

the Raleigh-EO.txt file. Click [Open]. The Data table will show the parsed EO information 

contained in the text file. 

11. Select [Next]. 

12. Data pairing is done automatically from the image IDs, which are identical to the filenames of 

the images in the demo dataset. If the image names in the session did not match the image 

names in the EO file, here is where you would pair the ingested images with the EO IDs. 

13. Select [Next]. 

14. The sensor models for all the loaded images have been specified. There will be an asterisk 

indicating that the sensor model, for the loaded image, has been changed. 

Checkpoint 

You have now ingested images and specified the sensor models for the images for your session. It is 

time to save the session, so that we can proceed to exploiting the imagery. 

1. From the Backstage, select [Save Session]. 
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2. A Save Data dialog will launch, asking if you want to save the data for the individual data items 

in the session. Selecting [Yes] will save the metadata for the images whose sensor models you 

just specified. 

3. The next dialog is the Save Session file dialog, where you can specify a filename and location for 

the session file. 
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4 VIEWING DATA 
In this lesson, you learn to interact with your data by: 

 Loading images into the viewers 

 Linking viewers 

 Viewer manipulation 

 Setting the active/visible layers 

4.1 IMAGE VIEWING 
Interacting with your imagery is the first step towards image exploitation, and the first step to 

interacting with the imagery is to look at the imagery. IApioneer works around the premise that most 

image processing workflows require, at most, two overlapping images of the feature to be collected. 

Thus, there are two image viewers:  the Left Viewer and the Right Viewer. Additional context viewers 

can be launched to provide access to more than two images simultaneously. 

To visualize the imagery: 

1. Click on the Home tab of the Ribbon. You will see a gallery of image thumbnails for the data 

loaded in the current session. 

2. Hover your cursor over a thumbnail. The image filename will be displayed. Locate the image 

with the name “SA1_058_59_hr4.tif.” 

3. Right click on the thumbnail and choose “Send to Left Viewer.” The image will be loaded into 

the Left Viewer of the application and a small arrow will appear in the bottom corner of the 

thumbnail in the Image Gallery to indicate which Viewer the image is loaded in. 

4. Locate the thumbnail of the image with the name “SA1_058_60_hr4.tif.” 

5. Right click on the thumbnail and choose “Send to Right Viewer.” The image will be loaded into 

the Right Viewer of the application and a small arrow will appear in the bottom corner of the 

thumbnail in the Image Gallery to indicate which Viewer the image is loaded in. 

Now that the images have been loaded into the Viewers, you can interact with them in preparation for 

your exploitation. You can change the brightness/contrast, pan and zoom, rotate, and more. 

To navigate the imagery: 

1. Click into the Left Viewer to make it active. A border will appear on the inside edge of the 

Viewer to indicate that it is the active Viewer. 

2. Use the mouse’s scroll wheel to zoom in and out. 

3. Click and drag with the middle mouse button (scroll wheel) to pan around the image. 
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4. From the Rotation group in the Home tab, use the pre-specified orientation buttons to rotate to 

a given position, or use the slider under [Compass] to set a custom orientation. 

5. From the Camera group in the Home tab, click [Camera Lock] to geospatially lock the Viewers.  

6. Pan and zoom in one Viewer, and note that the other Viewer maintains a geospatial link across 

viewers. 

Hint: Locking the cameras is a great way to maintain features in view for both Viewers while exploiting, 

especially when zoomed in. 

4.2 LAYER MANAGEMENT 
Data layers are types of data that can be overlaid on top of imagery to provide additional exploitation 

capabilities. IApioneer works with vector layers, tie point layers, and annotation layers. Data layers can 

be ingested like any other data, or created within IApioneer from the Session section of the Backstage. 

Layer management in IApioneer is accomplished in two ways, through visible and active layers. Any 

number of data layers can be visible, but only one layer can be active (editable) at one time. In this 

lesson, you will learn how to manage your data layers. 

Before we begin, let’s make sure that you have some layers to manage: 

1. From the Session section in the Backstage, click [Add Vector Layer]. A new vector layer will be 

added, “Unnamed Feature Set 1.” 

2. Right click on the vector in the list and choose “Save Data.” 

3. Set the data filename as “demo data.gvf.” 

4. Now, add a new vector layer and name it “demo data 2.gvf,” following the steps above. 

5. Next, add a new annotation layer by clicking [Add Annotation Layer]. A new annotation layer 

will be added, “Unnamed Annotation Document 1.gad.” 

6. Right click on the annotation layer and choose “Save Data.” 

7. Set the data filename as “demo annotation.gad.” 

Managing the data layers: 

1. Click on the Home tab. 

2. From the Data group on the Home tab, click on [Layer Manager]. This will expand the Layer 

Manager on the left side of the application, showing our two vector layers, each with a checkbox 

and radio button beside it. 

Hint: You can also show/hide the Layer Manager by clicking on the thin button nub on the left hand side 

of the Left Viewer. 

3. Select the checkboxes for all data layers. This makes all layers visible in the Viewers (though they 

contain no data for now). 
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4. Select the radio button for “Demo Data.gvf.” This makes the “Demo Data.gvf” the active, 

editable layer. 

Hint: If you need to quickly hide all the data layers, you can use the [Hide All] button on the Home tab, 

rather than individually deselecting each layer. 
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5 EXTRACTING 3D FEATURES 
Let’s start with a discussion on how our eyes perceive 3D in the world around us. Your eyes are 

separated, thus each perceives your surroundings from slightly different perspectives. Your brain 

interprets the different perspectives and combines the information into a 3D view of the scene. This 

allows you to perceive the 3D structure of your environment, determine depth and relative distance, 

and estimate height and elevation angles. 

In the same way, given any two images – with appropriate sensor model metadata – we can match 

features to provide accurate 3D information about those features. 3D FeatureXtract shrouds the 

complex equations and models of photogrammetry behind an easy-to-use user interface. 3D 

FeatureXtract does not require special hardware, as all the modeling is done in separate viewers, making 

the process simple, effective, and affordable – without the strain that comes with prolonged usage of 

active or passive stereo viewing hardware.  

In this lesson, you learn to extract features by: 

 Learning the creation and manipulation tools 

 Collecting 3D features 

 Editing features 

The Feature Extraction Creation group contains the basic geometries used to extract complex 2D and 3D 

features from the imagery. The types of geometries supported include: polygons, points, polylines, and 

circles. The creation tools are modal, meaning that one creation mode is active at all times. This allows 

you to quickly draw many items of the same geometry without having to return to the Ribbon. 

The Manipulation group contains the tools necessary to convert the drawn geometries to accurate 3D 

shapes by visibly aligning the geometries in the images. Making 3D models is simply a matter of drawing 

the shapes in one image, and then visibly aligning them in another. The available manipulation actions 

are: epipolar, z-axis, freehand, and rotation. Like the Creation tools, the Manipulation tools are modal, 

with one Manipulation mode active at all times. 

Hint:  To jump to the coordinates of the features specified in the stages below, use the [Jump to 

Location] option on the Home tab of the Ribbon. Set the coordinate system to Image Pixels, and type in 

the appropriate coordinates. 

To add a 3D polygon to the active layer: 

1. In the Creation group, select the [Polygon] gallery and choose [Draw Polygon]. 

2. Zoom in on the imagery to find a rectangular building. A good one to start with is at [x: 4600, y: 

7000] on image SA1_058_59_hr4.tif. 

3. In the left viewer, hold CTRL and click to set a vertex on a corner of the building’s roof. 

4. Release control and click on the next vertex of the building’s roof. 
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5. Continue clicking until all four vertices of the building’s roof have been measured. 

6. Right click to finalize the polygon. 

7. In the Manipulation group, set the manipulation mode to [Move Epipolar]. 

8. In the right image, click on the newly drawn polygon and drag it so that the polygon aligns with 

the roof edges of the building.  

9. Release the mouse button to set the 3D location of the polygon. 

10. Repeat steps 2-9 to add multiple polygons. 

 

Hint: Mis-click a point? You can use the Backspace key to remove the last vertex you placed. Or, if you 

wish to start completely over, use the ESC key. 

 

A circle is a special form of polygon that can be defined by designating any three points on its perimeter. 

To add a 3D circle to the active layer: 

1. In the Creation group, select [Circle]. 

2. Zoom in on the imagery to find a circular feature. A good one to start with is at [x: 4560, y: 

6530] on image SA1_058_59_hr4.tif. 

3. In the left viewer, hold CTRL and click to set a vertex on the perimeter of the circular feature. 

4. Release control and click on two more points lying on the circular feature’s perimeter. 

5. In the Manipulation group, set the manipulation mode to [Move Epipolar]. 

6. In the right image, click on the newly drawn circular polygon and drag it so that the polygon 

aligns with the perimeter of the circular feature.  

7. Release the mouse button to set the 3D location of the circular feature. 

8. Repeat steps 2-7 to add multiple circles. 

 

To add a 3D polyline to the active layer: 

1. In the Creation group, select [Line]. 

2. Zoom in on the imagery to find a linear feature.  

3. In the left viewer, hold CTRL and click to set a vertex for the first endpoint of the polyline. 

4. Release control and click on the next vertex of the polyline. 

5. Continue clicking until all vertices of the polyline have been measured. 

6. Right click to finalize the polyline. 

7. In the Manipulation group, set the manipulation mode to [Move Epipolar]. 

8. In the right image, click on the newly drawn polyline and drag it so that the polyline aligns with 

the feature in the image.  
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9. Release the mouse button to set the 3D location of the polyline. 

10. Repeat steps 2-9 to add multiple lines. 

 

To add a 3d point to the active layer: 

1. In the Creation group, select [Point]. 

2. Zoom in on the imagery to find a point feature.  

3. In the left viewer, hold CTRL and click to set the location of the point in the image. 

4. In the Manipulation group, set the manipulation mode to [Move Epipolar]. 

5. In the right image, click on the newly drawn point and drag it so that the point object aligns 

with the feature in the image.  

6. Release the mouse button to set the 3D location of the point. 

7. Repeat steps 2-6 to add multiple points. 

 

Snap to vertex locks the cursor to the nearest vertex within 5 pixels of the cursor. Moving the cursor 

more than 5 pixels “breaks” the snap. 

To snap to a vertex: 

1. Position the cursor close to an existing vertex. 

2. Begin a new geometry object by holding CRTL. 

3. While holding down the CTRL key, press and hold the SHIFT key to initiate snapping. 

4. Click to snap to the existing vertex. 

5. Release the CTRL and SHIFT keys and position the cursor close to another existing vertex. 

6. Press and hold the SHIFT key to initiate snapping. 

7. Click to snap to the existing vertex. 

5.1 EDITING 3D VECTORS 
To remove the last vertex placed in an object: 

 Press the Backspace key. 

To cancel drawing the current feature: 

 Press the ESC key. 

To reverse the last action: 
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 Undo (CTRL+Z) 

To redo the last action: 

 Redo (CTRL+Y) 

To select overlapping features: 

1. Click on an overlapping feature. 

2. In the Select Feature dialog, choose the feature you wish to select. The features are displayed in 

descending elevation order, and will be highlighted as you select them. 

3. Click [OK] to finalize the selection. 

4. Hold the SHIFT button and repeat steps 1-3 to add features to the selection. 

To delete a feature: 

1. Select the feature. 

2. Press the Delete key. 

 

  



UNCLASSIFIED 
 

UNCLASSIFIED 

®2015 IAVO Research and Scientific - IApioneer Demo Manual v3.0.3 – September 2015 Page 18 

6 BUILDING SIMPLE 3D MODELS 
In this lesson, you learn to create a simple 3D model by: 

 Extracting a building’s gutterline 

 Setting the 3D location of the gutterline 

 Extruding to ground 

 Adjusting elevations 

 

To extract the building: 

1. In the Creation group, select the [Polygon] gallery and choose [Draw Polygon]. 

2. Zoom in on the imagery to find a rectangular building with a superstructure. A good one to 

start with is at [x: 4600, y: 7000] on image SA1_058_59_hr4.tif. 

3. In the left viewer, hold CTRL and click to set a vertex on a corner of the building’s roof. 

4. Release CTRL and click on the next vertex of the building’s roof. 

5. Continue clicking until all four vertices of the building’s roof have been measured. 

6. Right click to finalize the polygon. 

7. In the Manipulation group, set the manipulation mode to [Move Epipolar]. 

8. In the right image, click on the newly drawn polygon and drag it so that the polygon aligns with 

the roof edges of the building.  

9. Release the mouse button to set the 3D location of the polygon. 

10. Select [Extrude Polygon(s)] from the Detailing group. The selected polygon will be extruded to 

an underlying elevation source, giving you a 3D building. 

To extract the superstructure: 

1. In the left viewer, hold CTRL and click to set a vertex on a corner of the building’s 

superstructure. 

2. Release CTRL and click on the next vertex of the building’s superstructure. 

3. Continue clicking until all four vertices of the building’s superstructure have been measured. 

4. Right click to finalize the polygon. 

5. In the Right Viewer, click on the newly drawn polygon and drag it so that the polygon aligns 

with the edges of the superstructure.  

6. Release the mouse button to set the 3D location of the polygon. 

7. Select [Extrude Polygon(s)] from the Detailing group. The selected polygon will be extruded to 

an underlying elevation source, giving you a 3D structure. 

8. In the Manipulation group, set the manipulation mode to [Move Z-Axis]. 

9. In the Right Viewer, click inside the bottom polygon of the extruded superstructure. 
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10. In the Select Feature dialog, choose the feature corresponding to the bottom of the extruded 

superstructure.   

11. Press [OK]. 

12. Click inside the selected polygon and drag the polygon up and down until the polygon aligns 

with the bottom of the superstructure. 

13. Release the mouse button to set the 3D location of the polygon. 
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7 BUILDING COMPLEX 3D MODELS 
In this lesson, you learn to create more complex 3D models by: 

 Combining simple shapes to make complex ones 

 Using the snapping tool to attach new geometry to existing vertices 

 Using the Detailing tools to add geometry to simple structures 

In the previous lesson, we covered how to extract simple 3D geometries. In this lesson, we will model 

more complex structures using combinations of simple geometries and the editing and detailing tools.   

To begin, we will focus on generating a building with a truncated pyramid roof, such as that found at [x: 

6800, y: 5800] on image SA1_058_59_hr4.tif. We will do so using two methods: using the snapping tool, 

and using the lofting tool. 

To extract a truncated pyramid using the snapping tool: 

1. Navigate to the building with a truncated pyramid rooftop. 

2. Extract the outer (larger) gutterline, as in Lesson 7, and Move Epipolar in the other image to set 

the 3D location. 

3. Extract the inner (smaller) gutterline. 

4. Hold the SHIFT (snapping) key and the CTRL key to snap to one vertex of the outer polygon. 

5. Release the CTRL key, but remain holding the SHIFT key and click on the corresponding vertex on 

the inner polygon. 

6. Continue in an anti-clockwise fashion, holding the SHIFT key while clicking on the next inner 

vertex, then the next outer vertex. 

7. Release the SHIFT key and right-click to finalize the polygon. 

8. Repeat steps 4-7 for the other three faces of the truncated pyramid. 

To extract a truncated pyramid using the lofting tool: 

1. Navigate to the building with a truncated pyramid rooftop. 

2. Extract the outer (larger) gutterline, as in Lesson 7, and Move Epipolar in the other image to set 

the 3D location. 

3. Extract the inner (smaller) gutterline. 

4. Drag-select both polygons. 

5. From the Detailing group on the FeatureXTract tab, select [Loft Feature]. The two features will 

be connected with a set of polygons forming the four faces of the truncated pyramid. 

3D FeatureXtract contains a number of pre-defined roof surfaces that can be used to speed up the 

process of roof extraction. Currently, you can use these tools to quickly generate Pitched (single- or 

multi-sloped) and Cylindrical (barracks, Quonset, etc.) roofs from rectangular base features. You can also 
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generate domes from circular base features. In this example, we will build a pitched roof, with a single 

hip, using the parametric roof building dialog and the freehand movement tools. 

To parametrically build a pitched roof: 

1. Zoom in on the imagery to find a rectangular building with a pitched roof. A good one to start 

with is at [x: 7300, y: 5200] on image SA1_058_59_hr4.tif. 

2. Extract the gutterline, as in Lesson 7, and Move Epipolar in the other image to set the 3D 

location. 

3. Ensure that the polygon is selected and choose Pitched from the [Build Roof] gallery on the 

Detailing group of the FeatureXTract tab. 

4. Set the Roof Axis to align with the feature in the image. For this building, the roofline lies along 

the Long axis. 

5. In the Create Pitched Roof dialog, use the up/down arrows in the Height field to set the roof 

height. As the value is changed, a preview of the roof structure will be shown in the Viewers. 

Align the roof ridgeline in both viewers to set the height of the roof. In this example, the roof 

height is about 1.5 meters. 

6. Set the # Layers field to 1, as this roof has only a single slope. For buildings with multiple roof 

slopes (e.g., barns with Gambrel-style roofs), set the field accordingly. 

7. Press [OK] to finalize the roof structure. The eastern roof peak is set properly, but the western 

side is hipped in by several meters. So, we need to adjust the western peak. 

8. Set the Manipulation mode to [Move Freehand]. 

9. Select only the vertex corresponding to the western peak of the roof. 

10. Click and drag the vertex until it aligns with the western roof peak in both images. 

11. Release the mouse button to finalize the single hipped pitched roof. 

 

Putting all of this together allows you to extract complex 3D structures from combinations of simple 3D 

geometries. As an example, we will extract the roofs of a building with several overlapping parts, using a 

combination of lofting and snapping. The building can be found at [x: 6500, y: 3800] on image 

SA1_058_59_hr4.tif. In most cases, it can be easier to model a structure if you start at the center top 

and work your way down and to the outsides. 

 

To build a complex structure with overlapping parts: 

1. Set the Creation mode to Polygon. 

2. Extract the gutterline of the main (square) part of the building, and Move Epipolar in the other 

image to set the 3D location. 

3. Extract the rectangular part of the peak of the main roof, and Move Epipolar in the other image 

to set the 3D location. 
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4. Select the polygons created in steps 2 and 3. 

5. Click [Loft Features] to create the main roof of the building. 

6. Extract the gutterline of the long rectangular attached structure on the left, and Move Epipolar 

in the other image to set the 3D location. 

7. Change the Creation mode to Line. 

8. Draw the ridgeline of the attached structure, and Move Epipolar in the other image to set the 

3D location. 

9. Use the snapping tool to connect the long side of the rectangular structure to the closest point 

of the ridgeline, making a triangular face. Place the points in anti-clockwise order to preserve 

the face normal. 

10. Repeat step 9 for the two narrow slanting faces of the attached structure’s roof. 

11. Repeat steps 6-9 for the two attached structures on the right. 
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8 EXPORTING YOUR 3D FEATURES 
In the previous lesson, you learned how to generate complex 3D models. In this lesson you will learn 

how to save your models and to export them into formats suitable for further exploitation in other 

applications. 

To save your vector layer: 

1. Go to the Session panel in the Backstage, accessed from the File tab. 

2. Right-click on the vector layer in the Vectors list, and choose the “Save Data” or “Save Data As” 

option. 

3. Provide a file name, and save the file. 

Note: The GVF format is a 3D FeatureXtract format optimized to work with our data structures. 

To export your data to another file format: 

1. Go to the Session panel in the Backstage, accessed from the File tab. 

2. Right-click on the vector layer in the Vectors list, and choose the “Export” option. 

3. Choose the desired Output Format. 

4. Click export to save the vector data as a new file in the specified format. 

Note: For ingestion into the True Ortho process, export in ESRI Shapefile format. 

To export your data to a textured format: 

1. Go to the Session panel in the Backstage, accessed from the File tab. 

2. Right-click on the vector layer in the Vectors list, and choose the “Export” option. 

3. Choose the desired Output Format that supports textured 3D models (such as Keyhole Markup 

Language). 

4. Check the Include Textures box. 

5. Click the Change button to specify the textures used for the automatic texturing process. 

6. From the GeoData list, select the textures to use for automatic texturing, and press [OK] to 

finalize the selection. 

7. Click export to save the vector data as a new file in the specified format. 
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9 ANNOTATING IMAGES 
In this lesson, you learn to annotate images by: 

 Placing simple annotation objects 

 Editing annotations 

 Using the MIL-STD-2525B clipart database 

 Performing linear and angular mensurations 

 Using the counting tool 

Before we can work with annotations, we need to make sure that we have an annotation layer as the 

active data. Use the [Layer Manager] on the Home tab to set an annotation layer as the active data layer 

by clicking on the radio button beside the annotation layer (demo annotation.gad). Select the Analysis 

tab to access the annotation layer tools. 

9.1 INSERT ANNOTATIONS 
To insert a new ellipse annotation: 

1. Select Ellipse from the [Shapes] menu. 

2. Click in the image and drag out the ellipse in a bounding box fashion. 

3. Release to set the ellipse. 

To insert a new point annotation: 

1. Select Point from the [Shapes] menu. 

2. Click in the image to place a circular point annotation. 

To insert a new polygon annotation: 

1. Select Polygon from the [Shapes] menu. 

2. Click in the image to set the first point of the polygon. 

3. Continue clicking to set the vertices.   

4. Right-click to finalize the polygon. 

To insert a new polyline annotation: 

1. Select Polyline from the [Shapes] menu. 

2. Click in the image to set the first point of the polyline. 

3. Continue clicking to set the vertices.   

4. Right-click to finalize the polyline. 

To insert a new rectangle annotation: 
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1. Select Rectangle from the [Shapes] menu. 

2. Click in the image and drag out the rectangle in a bounding box fashion. 

3. Release to set the rectangle. 

To insert a new textbox annotation: 

1. Select Textbox from the [Shapes] menu. 

2. Click in the image to set the textbox location. 

3. Type your desired text in the textbox. 

4. Click outside the textbox to finalize the text. 

To insert a new point marker annotation: 

1. Select Point Marker from the [Shapes] menu. 

2. Click in the image to set the point marker location. 

3. The point marker’s textbox callout is populated by the geospatial location of the point marker. 

To insert a new target circle annotation: 

1. Select Target Circles from the [Shapes] menu. 

2. Click in the image to set the target circles location. 

3. The target circle’s textbox callout is populated by the geospatial location of the point marker, 

and the rings are pulled from the default settings. 

To insert a new north arrow annotation: 

1. Select North Arrow from the [Shapes] menu. 

2. Click in the image to set the north arrow location. 

To insert a new clip art annotation: 

1. Select [Clip Art] to launch the Clip Art dialog. 

2. Navigate through the graphics library to find the desired clip art graphic. 

3. Click on the desired graphic and drag it into the viewer to the desired location. 

9.2 MEASUREMENT ANNOTATIONS 
To measure a separation angle: 

1. Click [Separation Angle] on the ribbon. 

2. Click in the image to set the first endpoint. 

3. Click in the image to set the pivot point. 

4. Move mouse to final location and click to set the final endpoint. 
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To measure a length: 

1. Click [Length] on the ribbon. 

2. Click in the image to set the first endpoint. 

3. Click in the image to set the second endpoint point. 

 To count objects in the scene: 

1. Click [Counting Tool] to launch the counting tool dialog. 

2. In the counting tool dialog, click [Add] to get a new category for counting. 

3. Click on the shapes dropdown to set the shape for the current marker. 

4. Set the color for the current marker. 

5. Click in the image to place a marker and increment the count for that category. 

6. Click [Add] to get another new category for counting. 

7. Set the marker style and color for the new category. 

8. Use the radio button to set the currently active category. 

9. Place a few markers in the image. 

10. Use [Remove] (x button) to remove all markers for the selected category. 

11. Set the active category to one with several markers already placed (or place some). 

12. Click on the eraser tool. 

13. Remove individual markers by clicking on them with the eraser tool active. 

To measure area, centroids, or perimeters of polygon objects: 

1. Click on an existing polygon annotation to select it. 

2. Right click on the selected annotation and choose Properties. 

3. Go to the Mensuration tab to see the measurement parameters for the selected annotation. 

9.3 EDITING ANNOTATIONS 
To edit the appearance of an annotation object: 

1. Create a new polygon annotation. 

2. Select the polygon by clicking on it. 

3. Right click on the annotation and choose Properties. 

4. Edit the display parameters such as the color, line style, or line weight for the annotation object. 

5. Click [OK] to finalize the new properties for the polygon display. 

6. Create a point marker annotation. 

7. Select the point marker annotation by clicking on it. 

8. Right click the annotation and choose Properties. 

9. Go to the Textbox tab of the properties dialog. 
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10. Edit the font styles, effects, and colors for the annotation. Note that the Sample text will update 

according to your selections. 

11. Click OK to finalize the new textbox properties. 

12. Double click inside the textbox for the point marker annotation. 

13. Type some new text to replace the existing location information. 

14. Click outside of the textbox to finalize the new text. 

Note: There are three categories of annotation properties: polygon, mensuration, textbox. Depending on 

the annotation object chosen, you may see more than one of these categories for editing. 

To edit the vertices of a polygon object once placed: 

1. Create a new polygon annotation. 

2. Select the polygon by clicking on it. 

3. Right click the selected polygon and choose Edit Points. The vertices of the polygon will be 

highlighted. 

4. Click and drag on a highlighted vertex to move it to a new position. 

5. Double click outside the selected polygon to finalize the new vertex position. 

 

A quadrilateral is a special form of polygon with four sides. IApioneer has the ability to subdivide a 

convex quadrilateral into a number of regularly sampled rows and columns. 

To subdivide a quadrilateral: 

1. Create a new convex four-sided polygon (such as a rectangle). 

2. Select the polygon by clicking on it. 

3. Right click the selected polygon and choose Properties. 

4. Right click the selected polygon and choose Subdivide to launch the Subdivide Polygon dialog. 

5. Use the up-down boxes to set the desired number of rows and columns for the subdivided 

polygon. See how the subdivisions change as you adjust the columns and rows. 

6. Click [Apply] to finalize the subdivision. The original polygon will be replaced with the new 

smaller polygons. 

Note: The parent polygon’s properties will propagate to the child polygons. This is a great way to 

regularly sample a grid, including the centroids for every sub-region. 


